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Trademarks: 

Beckman
®
, Biomek

®
 3000 ( Beckman Coulter Inc.); Roche

®
, LightCycler

®
 480 ( Roche 

Group); DyNAmoÊ
 
( Finnzyme Oy); SYBR

® 
(Molecular Probes Inc.); InvitrogenÊ, 

Platinum
®
 ( Invitrogen Corp.), MicroAmp

®
 ( Applied Biosystems); Microsoft

®
 , 

Windows
®
 7 (Microsoft Corp.). All other trademarks are the sole property of their 

respective owners.
 

 

 

Copyright Notice: 

No part of this manual may be reproduced or transmitted in any form or by any means, 

electronic or mechanical, for any purpose, without prior written permission of TIANGEN 

BIOTECH (BEIJING) CO, LTD . 
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1. Safety Precautions 

1. It is recommended to carefully read this operating manual prior to operating the 

T-Easy AP 400/600 Automated Pipetting System. To ensure safe operation and 

avoid problems that might arise while using the T-Easy AP 400/600 Automated 

Pipetting System, it is essential to observe the following points. Do not use the 

machine in a potentially explosive environment or with potentially explosive 

chemicals. 

2. Install the machine in location free of excessive dust. 

3. Avoid placing the machine in direct sunlight. 

4. Place the machine on a flat and sturdy surface, capable of withstanding the 

weight. 

5. The machine should be in an indoor temperature of 15 ~ 30̄C, relative humidity 

40 ~85%. 

6. Keep the side and rear of the machine at least 10cm from the wall or other 

machine. 

7. Make sure the power source conforms to the required power supply specifications. 

8. To avoid electric shock, make sure the machine is plugged into a grounded 

electrical outlet.  

9. Do not allow water or any foreign objects in the various openings of the machine.  

10. Switch off the machine prior to cleaning or performing service on the machine, 

such as replacing the fuses. 

11. Repairs should be carried out by authorized service personnel only.  

12. Open the lid only when the XYZ axes is not moving. 

13. Read and understand the Material Safety Data Sheets (MSDSs) provided by the 

manufacturers of the biological and chemical substances before you use and 

dispose.   

14. For research use only. When using the machine in diagnostic procedures with an 

in vitro diagnostic medical device, the IVD Directive should be applied 

separately. 

15. Users should be informed on the correct usage and user protection measures when 

handling hazardous substances. Use protective gloves when handling infectious 

substances (such as human samples or reagents). 

16. It is recommended to wear a mask and goggle to prevent users from inhaling 

hazardous vapors from the machine. 

17. Follow the manufacturerôs safety instructions when operating the machine. 
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 Pinching Hand Warning Label: Please be aware of pinching hands.  

 Electric Shock Warning: Please be aware of electric shock. 

 Warning: Please be aware of the dangers. 
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2. Product Introduction  

T-Easy AP 400/600 is an automatic, high-precision pipetting system specially designed 

for low-volume PCR/qPCR sample preparation. Its design concept is to replace tedious 

and repetitive pipetting of PCR/qPCR sample preparation traditionally performed by 

hand-held manual pipettor, and at the same time keep the operation of a manual pipettor. 

T-Easy AP 400/600 will save your time and money through reliable results. You will be 

assured to ñWork Smartò with the T-Easy AP 400/600. 

2.1 Features 

Easy to Use  

- Interchangable 4-position (T-Easy AP 400) or 6-position (T-Easy AP 600) 

96/384-well plate(SBS)/tip rack worktable and 2 reagent areas. 

- Software: APS can be mastered in one hour. No technician required. 

- Built-in PCR/qPCR setup protocols can be easily modified and transferred via 

USB memory stick. 

- 1/8-channel, 50µl  or 200µl , Automated Pipetting Module (APM) can be 

exchanged without tools. 

Easy to Afford 

- The most affordable Automated Pipetting System available in the market. 

- EzTipÊ robotic tips compatible with Beckman®
 Biomek

®
 3000 model. 

- CoolBlockÊ keeps sensitive reagents/samples for more than 60 minutes at 7 °C. 

- Saving reagent costs by reducing human errors and using more dense plates. 

Easy to Service 

- Mail-in calibration and service of Automated Pipetting Module (APM). 

- Online PC software update. 

- Compact and light-weight. 

Accurate and Precise 

- Automated Pipetting Module (APM) is calibrated by ISO-8655 standards. 

- Excellent results for qPCR standard curve and replicates. 

- Better Precision than manual pipetting. 
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2.2 Hardware Overview 

The T-Easy AP 400/600 Automated Pipetting System includes a base platform 

(ñT-Easy APò), an Automated Pipetting Module (APM), a control Notebook 

computer and other adapters for labwares. The base platform (T-Easy AP) is 

composed of the X/Y/Z axes motion mechanism, a power supply and some control 

circuit boards (PCBs) which are in charge of motion control, communication and 

APM control. More information is described below. 

 

2.2.1 Outlook  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1. Front View 

 

 

2 x Reagent Areas 

Automated Pipetting Module(APM) 

Acrylic Lid  

Disposable Used Tip Tray 

Door Detection Switch 4-position (T-Easy AP 400) or 6-position 

(T-Easy AP 600) SBS Worktable 

Door Magnet 

Notebook Computer 
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Note:  

SBS represents the Society for Biomolecular Screening (SBS). The SBS worktable and 

its adapters accommodate the SBS recommended labwares. 

Name Function 

Automated 

Pipetting 

Module(APM) 

APM is the core engine for accurate and precise pipetting. APM can 

be exchanged without tools. All APMs are calibrated using ISO-8655 

standards. The specifications of APM are shown in section 2.2.3. 

Acrylic Lid  Used for the protection of dust and emergency stop. The movement 

of XYZ axis will stop, once the Acrylic Lid is open. To ensure the 

Door Detection Switch is activated, close the front acrylic door to the 

door magnet and shut it tightly.   

2 x Reagent Areas R1/R2 Area: accommodates the R1 adapter for 2 x 4 1.5ml/2ml micro 

tubes, and the R2 adapter for 6 x 2ml free standing tubes and 1 x 5ml 

bottle, and reservoir adapter for 80ml reservoir. 

CoolBlockÊ adapters are available for Regent Areas. 

T-Easy AP 400: 

4-position SBS 

Worktable  

A/B/C Area: accommodates the elevated and CoolBlockÊ adapters 

for PCR plates/stripes/1.5ml tube, and deep well adapter for deep 

well plate. 

C/D Area: accommodates the tip racks. 

T-Easy AP 600: 

6-position SBS 

Worktable  

A/B/C/D/E Area: accommodates the elevated and CoolBlockÊ 

adapters for PCR plates/stripes/1.5ml tube, and deep well adapter for 

deep well plate. 

C/D/E/F Area: accommodates the tip racks. 

Disposable Used 

Tip Tray  

Capacity > 400 tips 

Door Magnet Lock the acrylic Lid into its place. 

Door Detection 

Switch 

The operation of XYZ axis will stop, once the door opening is 

detected. 

Notebook 

Computer 

Used in running the control software: APS. Microsoft
®
 Windows

®
 7 

operating system or higher version is included. 
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Note: 

To avoid any computer virus or software conflict, it is highly recommended 

not to connect the Notebook Computer with Internet and not to install any 

application software in this Notebook Computer.   

The calibration information of XYZ axes and labware adapters is stored in the 

APS control software. To switch the Notebook Computer between different 

T-Easy AP 400/600 units will lose the original calibration information and 

affect the positioning of adapters.     

 

 

 

 

 

 

 

 

Figure 2. Rear View 

 

Name  Function 

Power Cable 

Connector 

Power cable socket and fuse drawer. 

Power Switch Power On/Off switch. I: ON, O: Off.  

USB Port For connection with Notebook Computer.  

RS-232 Port For connection with computers that do not have USB ports. 

Air Vents For air ventilation.  

Product Label Indicates the model name, serial number, power specification, and 

other important information 

 

2.2.2 Control  Notebook Computer 

T-Easy AP 400/600 is controlled by a Notebook Computer. The specifications of 

the Notebook Computer can be upgraded to a higher performance model in the 

future. For detailed specifications and operation of the Notebook Computer., 

please read its User Guide, Quick Guide and product label carefully. The 

Microsoft
®
 operation software English Windows

®
 7 (or other higher version) and 

T-Easy AP 400/600 control software: APS is pre-installed in the Notebook 

RS-232 Port 

USB Port 

Power Cable 

Connector 

Power Switch 

Air Vents 

Product Label 
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Indication Light 

Fixation Bracket 

Tip Fitting  

Volume Engrave 

Computer. 

The methods and log files of APS can be transferred easily by an USB storage 

device, such as a memory stick and hard drive, or multi-card reader that accepts 

Secure Digital (SD), MultiMediaCard (MMC), and Memory Stick (MS).   

Minimal PC specifications required to run APS are as followed: 

 ̧1 gigahertz (GHz) or faster 32/64-bit (x86) processor 

 ̧1 gigabyte (GB) RAM (32/64-bit) 

 ̧16 GB available hard disk space (32/64-bit) 

 ̧DirectX 9 graphics device with WDDM 1.0 or higher driver 

2.2.3 Automated Pipetting Module (APM) 

Four different interchangeable APM models, including single and 8-channel for 

two volume ranges: 50µl and 200µl. Their product specifications are shown below. 

The function of APM can be seen in Figure 3. 1- and 8-channel APM. 

 

Catalog No. Channels 
Volume Range 

(µl)  

Increment 

(µl)  

Accuracy 

(Rel.±)  

Precision 

( Rel. CVʾ) 

OSE-APM150 1 1 ~ 50 0.5 7.0-1.0% 7.5-0.4% 

OSE-APM120 1 10 ~ 200 1 3- 0.8% 1-0.15% 

OSE-APM850 8 1~ 50 0.5 7.0-1.0% 7.5-0.4% 

OSE-APM820 8 10 ~ 200 1 3- 0.8% 1-0.15% 

 

 

 

 

 

 

 

 

 

 

 

 

 

      Figure 3. 1- and 8-channel APM 
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2.2.4 Labware Adapters 

T-Easy AP 400/600 supplies various adapters to accommodate different labwares. 

The list below shows the available adapters and labwares. To expand T-Easy AP 

400/600ôs flexibility, more new adapters will be designed in the future. Please take 

some time to visit our web site at www.tiangen.com for the latest adapters.  

The worktable has indented lines and symbols to display the 4-position (T-Easy 

AP 400, Area A/B/C/D) or 6-positon (T-Easy AP 600, Area A/B/C/D/E/F) and 

Reagent Area R1/R2. Inside the Areas, there are fixation holes for the positioning 

of adapters. Insert the pins of the adapters to these fixation holes to accurately 

position the adapters. 

CoolBlockÊ can maintain the sensitive samples/reagents at 7°C for more than 60 

minutes. The typical CoolBlockÊ ( refer Figure 4.) includes 2 parts: the Core and 

the Insulation Housing. To use CoolBlockÊ, store it in -20°C  freezer for more 

than 3 hours before use. The Insulation Housing will  maintain the low temperature 

of Core and position itself in the worktable. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4. CoolBlockÊ 96 Adapter 

 

 

 

 

 

 

Insulation Housing 

Core 

http://www.tiangen.com/
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Catalog 

no. 

Description Applied Labware Worktable 

Area 

Adapter 

OSE-A001 96 tips rack adapter  ̧96x50µl  tips rack 

 ̧96x200µl  tips rack 

C,D(400); 

C,D,E,F(600)  

OSE-A002 Elevated 96-well PCR 

plate adapter 

 ̧96-well PCR plates 

 ̧Single 0.2ml PCR 

tube 

 ̧0.2ml PCR strips 

A,B,C(400); 

A,B,C,D,E(600) 
 

OSE-A003 Elevated 384-well PCR 

plate adapter 

 ̧384-well PCR 

plates 
A,B,C(400); 

A,B,C,D,E(600) 
 

OSE-A016 Deep well plate adapter  ̧96-well deep-well 

plates 
A,B,C(400); 

A,B,C,D,E(600) 
 

OSE-A004 4 x 2 1.5ml tubes 

adapter 

 ̧1.5ml micro tubes 

R1,R2 

 

OSE-A005 3 x 2 2 ml storage tubes 

and 1 x 5ml bottle 

adapter 

 ̧2ml storage tubes 

 ̧5ml storage tubes R1,R2 

 

OSE-A006 CoolBlockÊ 96 

adapter for 96-well 

PCR plates 

 ̧96-well PCR plates 

 ̧Single 0.2ml PCR 

tube 

 ̧0.2ml PCR strips 

A,B,C(400); 

A,B,C,D,E(600) 
 

OSE-A007 CoolBlockÊ 384 

adapter for 384-well 

PCR plates 

 ̧384-well PCR 

plates 
A,B,C(400); 

A,B,C,D,E(600) 
 

OSE-A008 CoolBlockÊ R10 

adapter for 4 x 2 1.5ml 

tubes 

 ̧1.5ml micro tubes 

R1,R2 

 

OSE-A009 CoolBlockÊ R20 

adapter for 3 x 2 2 ml 

storage tubes and 1 x 

5ml bottle 

 ̧2ml storage tubes 

 ̧5ml storage tubes R1,R2 

 

OSE-A017 CoolBlockÊ 20 

adapter for 20-well 

1.5ml tubes 

 ̧1.5ml micro tubes 

 ̧2ml storage tubes 

A,B,C(400); 

A,B,C,D,E(600) 
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2.2.5 CoolBlockÊ Operation and Performance 

 ̧ Operation 

Prior to usage, store the CoolBlock
TM

 adapters in the freezer at -20°C  for at least 3 

hours. After removing the CoolBlock
TM 

adapter from the freezer to a normal room 

temperature environment, it will be required to stay on the bench for 5 minutes. 

Users can then put the labwares into the CoolBlock
TM

 adapter, and maintain the 

samples/reagents inside the labwares under 7°C  over 1 hour.  

 

 

 

 

 

 

Catalog 

no. 

Description Applied Labware Worktable 

Area 

Adapter 

OSE-A011 20-well 1.5ml adapter  ̧1.5ml micro tubes 

 ̧2ml storage tubes 

A,B,C(400); 

A,B,C,D,E(600) 
 

OSE-A013 Reservoir adapter with 

1 x 80ml reservoir 

 ̧80ml reservoir 

R1,R2 

 

OSE-A015 20 x 80ml reservoir  ̧80ml reservoir 

R1,R2 

 

OSE-A018 HLA typing adapter 

for 60/72 well 

 ̧60/72 well Terasaki 

Tray 
A,B,C(400); 

A,B,C,D,E(600) 
 

OSE-A019 HLA typing adapter 

for 96 well 

 ̧96 well Terasaki 

Tray 
A,B,C(400); 

A,B,C,D,E(600) 
 

OSE-A020 0.5ml tube adapter for 

20 well adapter 

 ̧0.5ml micro tubes 
A,B,C(400); 

A,B,C,D,E(600)  

Caution! 

Once the CoolBlock
TM

 adapter is removed from the freezer, do not 

immediately put the tubes into it. Otherwise, the samples in the tubes will 

freeze. 
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Warning! Do not autoclave the CoolBlock
TM

. 

 

Warning! Do not store the CoolBlock
TM

 under -20°C . 

 

 

 ̧ Performance 

All CoolBlock
TM

 adapters can maintain its temperature under 7°C  over 1 hour 

after being removed from -20°C  freezer. The temperature profile of CoolBlock
TM

 

96 and CoolBlock
TM

 R1 can be seen in the figure 5 and figure 6. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.2.6 Disposable Used Tip Tray 

The standard Disposable Used Tip Tray contains more than 400 x 200µl tips. The 

Disposable Used Tip Tray can be easily removed for used tips dumping and 

disinfection. To prevent contamination to samples or reagents, a disposable Tray 

Cover can be placed on top of the Disposable Used Tip Tray. 

 

 

 

 

Figure 5. The performance of CoolBlock
TM

 96 Figure 6.The performance of CoolBlock
TM

 R1 
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2.3 Software Overview 

APS is a powerful, graphic control software specially designed for the application of 

PCR/qPCR setup. For the ease of operation, all the procedures and labwares required 

for PCR/qPCR setup are considered during the product design phase. Notebook 

Computer and Microsoft
®
 Windows

®
 7 operating system are required for the 

operation of APS. 
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3. Getting Started 

3.1 Unpacking 

T-Easy AP 400/600 packaging is custom-made to protect the machine during 

transportation and unpacking. These materials are recyclable and 

environment-friendly. Please follow the procedures below and refer Figure 7 to 

unpack the instrument. 

1. Cut off the PET strapping bands of carton. 

2. Remove the Top Cover. 

3. Remove the Outer and Inner Side Walls by pulling it upward. 

4. Remove the Accessory Box Partition, Accessory Box. 

5. Remove the Top PE foam. 

6. Remove the T-Easy AP 400/600 from the Bottom PE foam and place it on a flat 

surface. 

7. Open the lid and remove the Fixation Bracket (Red, Figure 8), used in 

positioning the Y and Z axes during transportation, by unscrewing 7 screws. 

Screw the 7 screws back to the original holes. 

     

 

 

 

 

 

 

 

 

 

 

 

 

 

Note:  

1. Important!  Please remove the Fixation Bracket before operating T-Easy AP 

400/600. Failing to remove the Fixation Bracket before operation might 

damage the Y and Z axes.  

2. It is recommended to save the packing materials for future usage.   
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Figure 7. Unpacking of T-Easy AP 400/600  

Top Cover 

Outer Side Walls 

Top PE Foam 
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Figure 8. Removal the Fixation Bracket 

 

3.2 Content List 

Open the T-Easy AP 400/600 Automated Pipetting System package and check that 

you have the following items:  

 

1. T-Easy AP 400/600 with one 

1/8-channel, 50µl /200µl  APM 

attached. 

2. Operation manual x 1 

3. Electric fuse (3.15A) x 1 4. AC power cord (US/EU/UK plug) x 1 

5. Warranty card x 1 6. USB cable x 1 

7. Notebook Computer x 1 ( or higher 

performance model) with mouse 

8. APS control software DVD x 1 

( including USB driver and others) 

9. Disposable Used Tip Tray x 5 10. R1 Reagent Adapter x 1 (Option) 

11. R2 Reagent Adapter x 1 (Option) 12. 96 well Plate Adapter (Option) 

13. 384-well Plate Adapter (Option) 14. Tip Rack Adapter (Option) 

15. Other optional items  

 

 

If there are any missing, damaged, or incorrect items, please contact your distributor 

or sales representatives immediately. Other purchased optional items, such as 

adapters and accessories, might be included in the accessory boxes. 

 

Fixation Bracket 
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3.3 Instrument Installation   

Before running T-Easy AP 400/600, users are required to complete and confirm the 

simple hardware installations below. If these hardware installations are not 

implemented correctly, the APM module might not pick up the tips or liquid 

correctly and might collide with the labwares. This might damage the APM. 

3.3.1 APM Installation and Removal 

The interchangeable 4 Automated Pipetting Modules (APM) provide the 

flexibility and convenience. The standard T-Easy AP 400/600 package is installed 

with one single channel 50µl /200µl APM . For different liquid handling 

applications, users can order additional APMs. The removal and installation of 

APM are simple and do not require any hand tools. 

Please follow the steps below to remove the APM before exchanging a new one.  

1. Power off T-Easy AP 400/600 and Notebook Computer. 

2. Unscrew the APM Fixation Screw (Please see Figure 9). 

3. Hold the central section of APM around the metal Fixation Bracket. 

4. Push the APM outward to your body. 

5. Disconnect the Control Cable on top of the APM. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 9. APM Installation and Removal 

 

Fixation Bracket 

Control Cable 
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Follow these steps to install the APM: 

1. Hold the central section of APM around the metal Fixation Bracket. 

2. Slide and push the APM Fixation Bracket into the metal Docking Bracket of 

Z-axis. The holes of APM Fixation Bracket must connect with the one fixation 

pin in the front and two fixation pins in the rear of Docking Bracket of Z-axis 

firmly. Loosening the connection of these two brackets will affect the accuracy 

and precision. 

3. Firmly screw in the fixation. 

4. Connect the Control Cable at the top of the Z-axis to the APM. The connector 

of the Control Cable is directional. 

 

3.3.2 Adapters Installation 

There are currently 9 Adapters available for T-Easy AP 400/600. Refer to section 

2.2.4 for the applied labware products of these Adapters. Additional adapters will 

be available soon.  

The worktable of T-Easy AP 400 is divided into 6 Areas (A, B, C, D, R1, R2) 

through engraved lines and marks, while T-Easy AP 600 has 8 Areas (A, B, C, D, 

E, F, R1, R2). These are positioning holes for the Adapter installation in these 6 

Areas. To install the Adapters, insert the pins under the Adapters (96 tip rack 

adapter, R1 adapter and R2 adapter, etc.) or 4 rods around the Adapters (Elevated 

96-well PCR plate adapter and Elevated 384well PCR plate adapter) to the 

positioning holes of these 6 Areas. The Adapters for R1 and R2 Area are 

directional, while the Adapters for A, B, C, and D are non-directional. 

 

 

 

 

 

3.3.3 Disposable Used Tip Tray Installation  

A Disposable Used Tip Tray is placed on the left-hand side hollow section of the 

worktable. This Disposable Used Tip Tray can be removed by pulling it upward 

with the right and left-hand side of the tray. The hollow section of the worktable 

will position the Disposable Used Tip Tray correctly and prevent it from moving. 

The slot on the Tray Cover is used to prevent the sample or reagent from spilling 

when the ejected tips touch the bottom of the tray. 

Note:  

To ensure the correct positioning, no labware products should be placed on 

the worktable without the support of the Adapters.   
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Figure 10. Used Tip Tray Installation and Removal 

 

3.3.4 Computer Connection 

The standard package includes a Notebook Computer with pre-installed 

Microsoft
®
 Windows

®
 7 operating system or higher version and APS. Follow 

these steps to connect the Notebook Computer and T-Easy AP 400/600. 

1. Connect the Type B connector of the USB cable to the USB socket in the rear 

of the T-Easy AP 400/600. 

2. Connect the Type A connector of the USB cable to any USB socket of 

Notebook Computer. 

 

 

 

 

 

 

Note:  

An USB driver is pre-installed in the Windows
®
 7 operating system.   

Tray Cover 

Disposable Used Tip Tray 
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3.4 Power On the Instrument 

After the installing the T-Easy AP 400/600, place the labware products, such as tip 

rack, plates, and tubes ( with samples/reagents) on the Adapters.  

Proceed with the following steps to turn on the instrument. 

1. Power on the Notebook Computer.  

2. Power on T-Easy AP 400/600. The green indication light will be turn on and the 

Notebook Computer will  automatically recognize the USB driver of the T-Easy 

AP 400/600. The XYZ axes and APM will  perform a calibration routine. 

3. Double click the APS  on the Windows
® 

desktop to start the control 

software. 

4. The initial screen (such as the one below) will appear and ask for account and 

password entry.  

5. Key in the account name and password to login APS. To access APS, users can 

type in ñUserò as account name without entering a password.  

6. The Administratorôs account name is ñAdminò and the password is ñ0000ò. For 

security purpose, users should change the Administrator password in the 

System/Account menu after initial log-in. 
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Note:  

1. Account ID and password are case-sensitive. 

2. If the Administrator password is lost, please call the authorized 

distributor for help. 

3. If the lid is open when the T-Easy AP 400/600 is on, calibration routine 

will not be performed and a warning beep sound will continue. 

 

 

 

 

 

 

 

 

 

3.5 Starting APS Software 

Once users are in APS, follow these steps to check the connection between the 

machine (APS) and APM. 

1. A message window: ñApply APS and APM communication?ò will appear. Press 

ñOKò to perform the connection. ñDoneò will appear and press ñOKò to 

continue. 

2. Press ñCancelò to run APS without controlling T-Easy AP 400/600. The status 

barin the lower-left corner of Worktab will display ñSystem Offlineò.  

To run APS, please refer to chapter 4 to 6 for more information and advanced 

settings.  

3.6 Exiting and Shutting down 

When users are done with the T-Easy AP 400/600, exit APS and shut down T-Easy 

AP 400/600. 

To exit APS, select either Exit in the File menu or click ñXò at the top right corner of 

the APS worktab.   

To shut down T-Easy AP 400/600, switch off the Power Switch at the rear of T-Easy 

AP 400/600. The green indication light of APM will be turned off at the same time. 
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4. Software 

This chapter provides thorough information on the APS. All elements shown in the 

protocol file ( file format: *.aps ) screen, such as the Menus, the Toolbar, the graphic 

Worktable section for labware selection, the Protocol section for writing a series of 

commands, the Property section for the information of APM and pipetting data and the 

Run section, are covered in this chapter.    

4.1 Menu Map of APS Software 

APS includes 7 menu: File, Edit, Protocol, Labware, Report, System, and Help, 

which are located at the top of the protocol file screen. 

 

 

 

Each menus include their own function and sub-menus. The structure is shown in 

Figure 11. Menu Map. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 11. Menu Map 
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4.2 File 

The File Menu gives access to a number of file related functions which can be 

accessed via the Toolbar. 

 

 

 

 

 

 

 

 

 

 

 

New (Ctrl + N) 

This option allows the users to create a new protocol file ( file format: *.aps ). 

 

Open (Ctrl + O) 

This option opens an existing protocol file that can be modified to create a new 

protocol file, or used as it is. 

 

Save (Ctrl + S) 

This option saves the current setup to a protocol file. All available parameters are 

saved. 

 

Save As 

This option saves the current setup to a new protocol file. Users can modify an 

existing protocol and save as a new file name. 

 

Page Setup 

This option allows users to configure various options (size, margins, page orientation) 

related for print out.  

 

Print (Ctrl  + P) 

This option allows users to print the current protocol fileôs Protocol Report which 

includes the selected labwares, commands, property, and so on. 

 

http://www.computerhope.com/jargon/m/margin.htm
http://www.computerhope.com/jargon/p/pageorie.htm
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Preview 

This option allows users to preview the printing. 

 

Exit (Ctrl  + Q) 

This option allows users to close the software. 

 

4.3 Edit  

The Edit Menu allows users to create and modify the running protocol commands. 

All functions in the Edit Menu can also be accessed by right clicking the mouse 

button on the command tab. 

 

 

 

 

 

 

 

 

 

Delete 

This option allows users to remove a selected command. 

 

Duplicate (Ctrl  + D) 

This option allows users to copy a selected command. 

 

Exchange (Ctrl + E) 

This option allows users to exchange a selected command. 

 

Add 

This option allows users to add a new command. 

 

Insert (Ctrl  + I)  

This option allows users to insert a new command. 

 

Reset  

This option allows users to empty the source and destination setting of a selected 

command. 
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Sample Information (Ctrl + D)  

Clicking Total View in the Sample Information window will display all the selected 

wells. Users can key in each wellsô information in Sample Information window, and 

print the sample information under the Protocol Report (4.6.1). 

 

 

4.4 Protocol 

The Protocol Menu allows the operation of current protocol files. Some functions in 

the Protocol Menu can also be accessed via the Toolbar. 

 

 

 

 

 

 

 

Run (F5) 

This option allows users to run a protocol. 

 

Pause 

This option allows users to pause the protocol. 
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Stop 

This option allows users to abort the protocol. 

  

Prerun (F10)  

This option allows users to simulate the running process. 

4.5 Labware  

There are three sub-categories in the Labware menu: Tube, Plate and Tip. APS is 

pre-installed with the labware database for commonly used disposable robot tips, 

storage tubes/reagent vessels and 1 x 8 microstrips /96-well/384-well microplates.  

 

 

 

 

4.5.1 Enable the Tubes in worktable 

Under the Labware Tube window, check the ñEnabledò button for the selected 

tube brand and then click the ñSaveò button to save the settings. Close the 

Labware Tube window to go back to the APS window. 

 

 

 

 

 

4.5.2 Enable the Plates in worktable  

Please refer to Section 4.5.1 to enable the plates in worktable, and also check 

Dockable Area for the plates to be placed in the selected areas (Area A/B/C in 

T-Easy AP 400, Area A/B/C/D/E in T-Easy AP 600). 
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4.5.3 Enable the Tips in worktable 

Please refer to Section 4.5.1 to Enable the tips in worktable. 

4.6 Report 

The Report Menu allows users to review a protocol report and log records. 

 

 

 

 

 Protocol 

This option allows users to review a summary of the protocol parameters and 

reactions configuration. 

 Log 

This option allows users to review actions that have occurred during system 

operation. 

4.6.1 Protocol Report 

Click the Protocol option under Report Menu. The opened ñProtocol Reportò 

contains the run set up with the following information on: 

ü The protocol name, description and saving location. 

ü Automated pipetting module (APM) information 

ü All commands settings including Source, Destination, Pipetting Volume, 

Pipetting Speed, Mixing etc. 

ü Tip information including brand, type, capacity volume and the amount 

required during the run. 

ü Labware configuration, brand, location and the amount of reagent required 

during the run. 

ü The current time and date. 

ü Software version 
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4.6.2 Log Report 

The log report records every step of a run. Users can tick off ñLogò on the System 

Menu (System/Software/Log). A log will be automatically generated when every 

protocol is started. Please note that the log will be automatically saved in the APS 

file (C:\Document\ APS). 

To review the log report, proceed as follows.  

ü Open the protocol for the corresponding log that you want to review. 

ü Click the Log option of Report Menu to display the log record. 
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ü Select a log that you want to review. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 




































































































































